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Voorwoord 
 
Deze stage-opdracht is uitgevoerd in opdracht van de Technische Universiteit Delft, Faculteit Civiele 
Techniek en Geowetenschappen, Subfaculteit Geodesie. 
 
Na een algemene inleiding in hoofdstuk 1 volgen de hoofdstukken 2 en 3 met meer informatie over Radio 
TV West en het “Verkeersjournaal”. Deze twee hoofdstukken zijn bedoeld voor lezers die meer over deze 
onderwerpen te weten willen komen. Hoofdstuk 5 is zeer theoretisch en legt daarmee een kleine basis 
onder het onderzoek. In hoofdstuk 6 staat beschreven wat ik allemaal heb uitgevoerd en in hoofdstuk 7 
staat mijn beleving van de stage centraal. De appendix is tenslotte belangrijk voor degene die mijn 
werkzaamheden in de toekomst gaat overnemen. 
 
Speciale dank gaat uit naar mijn begeleider van het eerste uur Toon Lampe. Mijn dank gaat ook uit naar 
mijn directe collega’s bij Radio TV West, in het bijzonder naar Mischa van Vlier, naar mijn begeleiders bij 
Radio TV West, naar Ron Fresen en Richard Hogenkamp en zeker naar mijn begeleider van Geodesie 
Edward Verbree. Verder wil ik Rob Gieb van het “Stadsgewest Haaglanden” en Jan Willem van Eck van 
softwarebedrijf “ESRI” bedanken voor hun support en Marian de Vries voor haar hulp met “ArcIMS” en het 
gebruik van haar computer. 
 
 
Martine Hoefsloot 
September 2004 
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Samenvatting 
 
Het “Verkeersjournaal” brengt het laatste nieuws over verkeer en mobiliteit in de regio Haaglanden. Het 
“Verkeersjournaal” informeert de kijkers kort en overzichtelijk over de actuele bereikbaarheid in de regio. De 
regionale knelpunten voor automobilisten, fietsers en andere weggebruikers worden in kaart gebracht. De 
uitzendingen worden gemaakt in samenwerking met de gemeente Den Haag, de HTM NV en Bereikbaar 
Haaglanden. Bij Radio TV West bestond het idee om voor het maken van kaarten een GIS in te zetten en 
de mogelijkheden daarvan ten volle te benutten. 
 
Het doel van de opdracht is om het gehele geo-informatievoorzieningsproces van de aankondiging van 
wegopbrekingen en evenementen tot aan de uiteindelijke visualisatie op de televisie letterlijk in beeld te 
brengen. De opdracht bestaat uit 3 delen: 

 Het werkproces, voor het samenvoegen van data in ArcGIS 8 ten einde een kaartje te krijgen voor het 
“Verkeersjournaal”, in beeld brengen en het schrijven van een werkwijze, zodat iemand de 
werkzaamheden voor het “Verkeersjournaal” over kan nemen. 

 Het onderzoeken van de toepassing van GIS technologie in de nieuwsomgeving, het is uiteindelijk de 
bedoeling om serieuze infographics te maken van actuele zaken voor bijvoorbeeld het journaal. 

 Op zoek gaan naar meer (technische) ontwikkeling, bijvoorbeeld GIS in combinatie met luchtfoto’s of 3D 
informatie. De kosten van data zou bij dit onderdeel geen probleem mogen zijn. 

 
Om deze opdracht uit te kunnen voeren zijn een aantal zaken belangrijk. Allereerst moet het 
softwarepakket “ArcGIS 8, ArcMap” van “ESRI” bestudeerd worden, een uitgebreide werkbeschrijving voor 
het maken van kaarten is te vinden in de Appendix. Verdiepen in literatuur over GIS in de journalistiek is 
ook belangrijk evenals literatuur over het gebruik van afbeeldingen op de televisie, deze kennis is 
specialistisch, maar al in bezit van Radio TV West. 

Het in de praktijk brengen van alle opgedane kennis is even zo belangrijk. Het was de bedoeling zo snel 
mogelijk het kaartenmaken over te nemen van Rob Gieb, standaard bestanden te maken en het proces zo 
veel mogelijk te automatiseren. Infographics in het nieuws zijn alleen nuttig indien ze ook een bijdrage 
leveren aan de informatieoverdracht. 

Omdat de theorie en de praktijk niet gelijk zijn en geld in de periode waarin de stage valt weldegelijk een 
rol speelt, is het waarschijnlijk niet eenvoudig een betere ondergrond te vinden. Een oplossing hiervoor is 
gevonden in de kleurkeuze en de opmaak van de kaarten ook mogelijkheden voor het publiceren van 
kaarten, al dan niet interactief, op het internet zijn onderzocht. 
 
De resultaten uit dit onderzoek moeten worden gezien in het licht van de financiële en personele problemen 
die Radio TV West heeft gezien. De werkzaamheden voor het maken van de kaarten zijn volledig 
overgenomen en er zijn diverse infographics voor het journaal van Radio TV West gemaakt. Ook op het 
internet zijn resultaten geboekt. Zo is er een website met daarop een webmapping-service gemaakt. Deze 
is niet in gebruik, omdat de webmapping-service niet naar behoeven functioneert. Bovendien heeft het 
“Verkeersjournaal” een beperkte pagina op de website van Radio TV West en bleek het niet mogelijk de 
website eenvoudig up-to-date te houden. 
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1 Inleiding 
 
Het “Verkeersjournaal” brengt het laatste nieuws over verkeer en mobiliteit in de regio Haaglanden. Het 
“Verkeersjournaal” informeert de kijkers kort en overzichtelijk over de actuele bereikbaarheid in de regio. De 
regionale knelpunten voor automobilisten, fietsers en andere weggebruikers worden in kaart gebracht. Maar 
ook aan het openbaar vervoer wordt aandacht besteed. Bij wegwerkzaamheden en evenementen worden 
de omleidingroutes en andere alternatieven aangegeven. Daarnaast geeft het programma regelmatig door 
middel van korte achtergrondinformatie aan waarom bijvoorbeeld wegwerkzaamheden, omleidingen en 
verkeersveiligheidsacties nodig zijn. De uitzendingen worden gemaakt in samenwerking met de gemeente 
Den Haag, de HTM NV en Bereikbaar Haaglanden (het samenwerkingsverband van stadsgewest 
Haaglanden, provincie Zuid-Holland en Rijkswaterstaat). Radio TV West zendt het “Verkeersjournaal” 
iedere dag (behalve zaterdag) uit, het programma wordt regelmatig herhaald. 

Tot nu toe werden de kaarten door vormgevers gemaakt, die telkens weer alle benodigde gegevens 
moesten verzamelen om deze vervolgens goed in beeld te brengen, een bewerkelijk proces. Bij Radio TV 
West bestond het idee om hiervoor een GIS in te zetten en de mogelijkheden daarvan ten volle te benutten. 
Hiervoor zochten zij een afstudeerder of eventueel een stagiair. 
 
Dit rapport is het eindresultaat van 6 maanden parttime stage. Het doel van de opdracht was om het gehele 
geo-informatievoorzieningsproces van de aankondiging van wegopbrekingen en evenementen tot aan de 
uiteindelijke visualisatie op de televisie letterlijk in beeld te brengen. 
 
De opbouw van dit rapport is als volgt. In hoofdstuk 2 wordt een globale beschrijving gegeven van het 
bedrijf “Radio TV West” en van de financiële problemen waarmee het bedrijf te maken heeft gehad. In 
hoofdstuk 3 wordt dieper ingegaan op het programma het “Verkeersjournaal”. In hoofdstuk 4 worden 
vervolgens de stage-opdracht en de werkwijze besproken. Hoofdstuk 5 legt een theoretische basis voor het 
gehele onderzoek. De behaalde en niet behaalde resultaten komen in hoofdstuk 6 aan de orde en in het 
laatste hoofdstuk een zelfreflectie naar aanleiding van de gehele stage. 
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2 Radio TV West in vogelvlucht 
 
Dit hoofdstuk beschrijft het bedrijf Radio TV West. Het hoofdstuk is opgedeeld in drie paragrafen. De eerste 
paragraaf beschrijft het bedrijf in zijn algemeen, paragraaf 2.2 geeft een beetje inzicht in de problemen die 
spelen bij de omroep en de laatste paragraaf levert een overzicht van de programmering op de TV. Het 
merendeel van de informatie is afkomstig van de website van Radio TV West en een klein deel komt uit het 
rapport Welters (2003) en de officiële samenvatting daarvan (2003). 
 
 
2.1 Het bedrijf 
 
Zuid Holland is een bijzondere provincie in omroepland. De provincie heeft twee publieke regionale 
omroepen: Rijnmond en Radio TV West. Rijnmond zendt uit voor het zuidelijke deel van de provincie. Het 
noorden van de regio is voor Radio TV West. De regio van Radio TV West loopt van het Westland tot de 
Bollenstreek en van Gouda tot Scheveningen. Het is een regio van verschillen. Van het agrarische 
Westland tot het kosmopolitische Den Haag. Er zijn twee universiteiten: de klassieke Universiteit Leiden en 
de vooruitstrevende Technische Universiteit Delft. (Website Radio TV West) 
 
De medewerkers van Radio TV West hebben oog en oor voor de ontwikkelingen in de regio; voor de 
problematiek van de grote stad en het platteland. Ze zijn niet bang om daarbij ook over de grenzen van de 
regio te kijken. Het spreekt voor zich dat ze daarbij altijd in de gaten houden wat de gevolgen zijn voor de 
mensen in de regio. Er is natuurlijk ook aandacht voor de aangename kanten van het leven in de regio. Zo 
is er op 89.3 Radio West en TV West veel aandacht voor cultuur, muziek en uitgaan. 

De financiering van Radio TV West komt uit publieke middelen. Het publieke karakter van de omroep 
houdt een grote verantwoordelijkheid in ten opzichte van de inwoners van de regio. Alle middelen, ook de 
inkomsten uit reclamegelden, worden ingezet voor het maken van goede programma’s. Een bijzondere 
verantwoordelijkheid heeft Radio TV West in geval van calamiteiten. Dan fungeert de omroep als 
rampenzender. Radio TV West heeft daarvoor snelle verbindingen met hulpverleningsinstanties en een 
noodaggregaat die de continuïteit waarborgt, ook als de stroom uitvalt. (Website Radio TV West) 
 
 
2.2 Bezuinigen en dan? 
 
De regionale stations in Zuid-Holland zitten in grote financiële problemen, nu de provincies verantwoordelijk 
zijn voor de financiering van de regionale omroep. De provinciebesturen staan voor de vraag of zij wel 
voldoende het belang inzien van volwaardige regionale stations. 
 
Radio TV West is één van deze regionale zenders die in de problemen is geraakt. Om faillissement te 
voorkomen heeft de provincie een voorschot gegeven op de subsidie voor 2004, maar omdat dit niet 
voldoende is om Radio TV West erbovenop te helpen, hebben dinsdag 21 oktober 2003 42 van de 170 
medewerkers van Radio TV West hun ontslag aangeschreven gekregen. Een extern onderzoeksbureau is 
een onderzoek gestart naar de problemen bij zowel Radio TV West als Radio TV Rijnmond, de resultaten 
van dit onderzoek zijn bekendgemaakt op dinsdag 2 december 2003. In het rapport wordt als oorzaak 
genoemd: een opeenstapeling van factoren in betrekkelijk korte tijd ( 2001-2003) heeft geleid tot de huidige 
financiële positie van de omroep: 

 De afkoopsom van de voormalige directeur (2000-2001) = eenmalige kosten; 
 extra kosten voor interimmers, waaronder een directeur a.i. en de werving van een nieuwe directeur 

(2001) = eenmalige kosten; 
 een inadequate financiële administratie (2001 tot heden) = ontbreken van gedegen informatie, waarop 

beslissingen kunnen worden gebaseerd; 
 aanpassing van de personele organisatie (2000-2002) en uitbreiding van het personeel (2001-2002); het 

personeelsbestand is veel te groot = structureel; het organisatiemodel kent te veel overhead (te veel 
chefs). 

 forse stijging van de huisvestingslasten ten gevolge van de huur van het huidige pand, verbouwings- en 
inrichtingskosten (2001-2002); de huisvestingskosten zijn veel te hoog = structureel; 

 investeringen met geleend geld (2002-2003); dubbele lasten = structureel; 
 andere forse kostenstijgingen, waaronder uitbreiding van het autopark (2001-2002) = structureel; 
 wijziging van de radio-format, waardoor behalve luisteraars ook de adverteerders wegliepen (2002-

2003), geeft nog lang na-effecten; 
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 onder de maat presteren van de ORN (landelijke reclame) (2001- 2003);  
 een aantal andere factoren, zoals het onvoldoende bewaken van debiteuren e.d. (2001-2003). 

 
Sommige factoren zijn mede het gevolg van de fusie tussen radio en TV in 2000, die grote spanningen in 
de organisatie teweegbracht en Radio TV West ook confronteerde met de erfenissen van het voormalige 
TV bedrijf. In een aantal gevallen zijn beslissingen genomen, bij een gebrekkige financiële administratie, 
met hoge structurele kosten als gevolg. Andere factoren zijn meer het gevolg van beleidswijzigingen (vooral 
sinds 2002), deze hebben de al bestaande structurele problemen vergroot en nieuwe geschapen. 
 
Samenvattend kan gezegd worden dat: Niet alleen het huidige overheidsbeleid, maar ook management 
problemen hebben ervoor gezorgd dat het zover kon komen. Door onder andere onderzoeksresultaten 
foutief te citeren heeft voormalig omroepdirecteur Jeroen Soer (nu directeur bij de VARA) een radioformule 
(talkradio) opgestart, die veel luisteraars naar andere omroepen deed vertrekken, Jeroen Soer mag niet 
alleen de schuld krijgen van de ontstane problemen, niemand heeft ingegrepen wanneer beslissingen 
genomen werden. Gevolg van het dalen van de luistercijfers is dat de reclame-inkomsten dalen, omdat er 
dan ook minder mensen naar de reclame luisteren. Tegelijkertijd stegen de huisvestings- en de 
personeelskosten, zodat de omroep nog dieper in de nu bekende problemen kwam te zitten. Verder blijkt uit 
de resultaten dat er € 5,3 miljoen nodig is om Radio TV West erbovenop te helpen en dat daarnaast nog 
een uitgebreid sanerings- en zelfreiningsplan moet worden uitgevoerd. Over het al dan wel niet behouden 
van Radio TV West (en ook Radio TV Rijnmond), door het toezeggen van (een deel van het) geld, deed de 
provincie op 17 december 2003 uitspraak. Het voortbestaan van de stageplaats waaraan dit rapport hangt, 
was afhankelijk van de uitspraak op deze dag. Provinciale Staten besloot toen om tot en met februari 2004 
geld te geven aan Radio TV West en Radio TV Rijnmond en een nader onderzoek in te stellen. 

Op 18 februari 2004 heeft Provincie Zuid-Holland besloten dat zij de omroepen Radio TV West en RTV 
Rijnmond overeind houdt. Provinciale Staten (PS) stemden bijna unaniem in met een pakket aan leningen 
en bijdragen van in totaal ruim 7 miljoen euro. Alleen de leden van LPF en Leefbaar Zuid-Holland stemden 
tegen. Een groot deel van de bijdragen is de afgelopen maanden beschikbaar gesteld, in de vorm van 
achtergestelde leningen en vooruitbetaalde subsidies. RTV Rijnmond krijgt nu nog 0,5 miljoen euro, Radio 
TV West nog 3,75 miljoen aan aanvullende leningen. (nieuwsbericht Radio TV West, 2004) 

 
De oude radioprogrammering is per 21 oktober 2003 weer opgezet in de hoop luisteraars terug te winnen 
voor de omroep. Dit lijkt te lukken, er zijn al diverse positieve reacties geweest op de hernieuwde opzet met 
onder andere radiospelletjes in de ochtenduren. Maar, met kwart minder mensen neemt de werkdruk bij de 
overgebleven medewerkers toe, zij moeten zich flexibel opstellen in de hoop de omroep en hun baan te 
behouden, dit is niet altijd even eenvoudig en veel werknemers hebben inmiddels zelf een andere baan 
gevonden. 
 
 
2.3 De programmering 
 
Naar aanleiding van het onderzoek is vastgesteld dat de omroep in ieder geval minstens geld moet hebben 
om 24 uur per dag radio te maken en één uur televisie. Televisie maken is heel duur en vernieuwen is 
belangrijk, daarom worden uitzendingen van andere omroepen ingekocht, zendtijd verkocht en alle 
programma’s worden herhaaldelijk uitgezonden. Er zijn ook programma’s die door andere partijen 
gefinancierd worden, één daarvan is: het “Verkeersjournaal”, meer over dit programma in de volgende 
hoofdstukken. 
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3 Het “Verkeersjournaal” 
 
Het “Verkeersjournaal” brengt het laatste nieuws over verkeer en mobiliteit in de regio Haaglanden. De 
uitzendingen worden gemaakt in samenwerking met de gemeente Den Haag, HTM en Bereikbaar 
Haaglanden (het samenwerkingsverband van stadsgewest Haaglanden, provincie Zuid-Holland en 
Rijkswaterstaat). Radio TV West zendt het “Verkeersjournaal” iedere dag (behalve zaterdag) uit, het 
programma wordt regelmatig herhaald. (naar: Website Radio TV West). In paragraaf 3.1 wordt het project 
het “Verkeersjournaal” besproken, waarna in paragraaf 3.2 het programma-concept wordt voorgelegd, 
paragraaf 3.3 geeft de participerende partijen en personen weer en de informatiestromen die ontstaan bij 
het maken van het “Verkeersjournaal”, paragraaf 3.4 tot slot beschrijft de taken van de diverse 
programmamedewerkers binnen Radio TV West. 
 
 
3.1 Het project: het “Verkeersjournaal” 
 
Het “Verkeersjournaal” informeert de kijkers kort en overzichtelijk over de actuele bereikbaarheid in de 
regio. De regionale knelpunten voor automobilisten, fietsers en andere weggebruikers worden in kaart 
gebracht. Maar ook aan het openbaar vervoer wordt aandacht besteed. Bij wegwerkzaamheden en 
evenementen worden de omleidingroutes en andere alternatieven aangegeven. Daarnaast geeft het 
programma regelmatig door middel van korte achtergrondinformatie aan waarom bijvoorbeeld 
wegwerkzaamheden, omleidingen en verkeersveiligheidsacties nodig zijn. (Website Radio TV West) 
 
Het “Verkeersjournaal” is opgezet als een pilot project in samenwerking met diverse partijen van verkeer en 
vervoer in de regio Haaglanden. De eerste fase van de pilot liep tot oktober 2003 en is verlengd tot januari 
2004. Malou Landré heeft het project destijds voor Radio TV West binnengehaald, omdat de kijkers van 
Radio TV West behoefte hadden aan informatie over wegwerkzaamheden in de regio. 

Onderhandelingen over een vervolg zijn gevoerd, alle partijen zijn tevreden over het programma en het 
haalt geld binnen voor Radio TV West, dus de doorgang van het programma hangt vooral af van de 
voortgang van Radio TV West zelf, van één van de partners of van andere problemen met een financiële 
aard. Tijdens de onderhandelingsfase wordt een programma-concept opgesteld voor de uitvoering van het 
programma, paragraaf 3.2 geeft het programma-concept weer. 
 
 
3.2 Het programma-concept van het “Verkeersjournaal” 
 
In de overeenkomst die getekend is door de partijen die participeren in het “Verkeersjournaal”, is een 
programma-concept opgenomen, waarin een aantal gezamenlijke uitgangspunten is geformuleerd. In 
onderstaand kader staat het programma-concept afgedrukt (uit: Verkeersjournaal Vervolgcontract). 
 
 
Programma-concept 
 
Inleiding 
Het programma beoogt de inwoners in het uitzendgebied van Radio TV West te informeren over de actuele verkeers- en vervoersinformatie, met 
name informatie over wegwerkzaamheden, waardoor weggebruikers en gebruikers van het openbaar vervoer uit deze regio de mogelijkheid 
hebben om oponthoud te vermijden. Daarnaast biedt het programma informatie over infrastructurele projecten, maatregelen en campagnes of 
acties binnen de regio om de bereikbaarheid, leefbaarheid en verkeersveiligheid van de regio te waarborgen c.q. te verbeteren. 
 
Communicatiedoelen 
Het programma heeft de volgende doelen: 

 Het leveren van verkeersinformatie; 
 Het kennisniveau over de projecten en maatregelen die de overheid treft ten behoeve van de bereikbaarheid, leefbaarheid en 

verkeersveiligheid bij de doelgroep te verhogen; 
 Het vergroten van begrip bij de doelgroep voor de noodzaak van wegwerkzaamheden en vervoersmaatregelen; 
 Het stimuleren van het zoekgedrag naar extra informatie naar aanleiding van de programma’s op teletekst om daardoor wel eens van tijdstip, 

route of vervoerswijze te veranderen. 
 
Doelgroep 
Primaire doelgroep zijn de inwoners in het uitzendgebied van Radio TV West die direct of indirect te maken krijgen of hebben met 
werkzaamheden en campagnes of acties van de overheid. De actuele verkeersinformatie richt zich met name op: 

 zakelijk verkeer (waar onder woon-werk en beroepsverkeer) 
 sociaal-recreatief verkeer 

 
Inhoud 
De inhoud van het programma heeft betrekking op: 
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 De actuele situatie op de weg in de regio (werkzaamheden, afsluitingen, voortgang en dergelijke). Dit wordt ondersteund door een verwijzing 
naar waar men de meest actuele informatie kan opvragen; 

 Voorlichting over de verschillende manieren die er zijn om de gestelde doelen (bereikbaarheid, leefbaarheid en verkeersveiligheid) te 
realiseren. 

De onderwerpen dienen een regionaal belang te vertegenwoordigen. 
 
Vorm en programma-indeling 
De ambtelijke partijen hechten aan een vaste indeling van het programma. De ‘handtekening van de overheid’ wordt gevormd door de leaders 
en/of de bumpers. Iedere uitzending heeft de volgende ingrediënten: 

 intro-leader; 
 zeer kort: de gebeurtenissen van de volgende dag; 
 aankondiging van actuele informatie en een achtergrond item; 
 actualiteiten met achtergrond informatie (met informatie verwijzing); 
 achtergrond item (indien tijd beschikbaar); 
 afscheid gevolgd door aftiteling. 

In het programma wordt gebruik gemaakt van graphics en bewegend beeld. Beelden verhogen de herkenbaarheid van de plek en kunnen ook de 
voorgang van een bepaald project laten zien. Alleen als daar goede redenen voor zijn wordt van deze vorm afgeweken. De lengte van het 
programma is minimaal 3 minuten per aflevering mits voldoende basismateriaal wordt aangeleverd door de participanten. 
 
Actuele verkeersinformatie 
Bij werken aan rijkswegen kan bijvoorbeeld verwezen worden naar de mogelijkheden die er in deze regio zijn om actuele verkeersinformatie 
(maximaal 5 minuten oud) te verkrijgen op regionale teletekst. Hierdoor ontstaat een programma, dat naast achtergrond informatie ook een 
daadwerkelijke mogelijkheid biedt voor automobilisten (die met de auto weg willen) om eventuele files te ontlopen dan wel in te plannen. Ook 
wordt verwezen naar de website(s) met actuele informatie over werkzaamheden aan de weg. 
 
Tone of voice 
De tone of voice is neutraal, informerend en onderhoudend en moet mede invulling geven aan de imagokenmerken open en deskundig. De 
presentatie is menselijk, persoonlijk en oplossend. 
 
Promotie 
Radio TV West en de ambtelijke partijen zetten middelen in om het programma bekendheid te geven, te weten: Promo’s en aankondigingen van 
het programma worden regelmatig ingezet. In voorkomende gevallen zal ook de mogelijkheid van specifieke promo’s gebruikt kunnen worden. Op 
teletekst staat vanaf de ochtend voor de uitzending de inhoud vermeld van het programma van die dag. Ook zal het programma worden 
gepromoot via de website van Radio TV West en via media van de overige participanten en HTM. Ter bespreking hiervan zullen 
promotiedeskundigen van alle partijen bijeenkomen. Aankondigingen staan ook in huis-aan-huisbladen, waarin wekelijks een programmaoverzicht 
wordt geplaatst. 

Met enige regelmaat, wanneer daar aanleiding toe is bij bijzondere onderwerpen, worden persberichten verstuurd. Plaatsing daarvan is in de 
handen van de media die dit ontvangen. Voor Radio TV West geldt dat via de radio dagelijks even voor 18.00 uur een opsomming van de 
programma’s op de TV wordt gegeven. De ambtelijke partijen zullen zich voor de promotie van het programma in hun uitingen zoals een 
aankondiging op websites, advertenties en e-mail berichten intern verspreiden, inspannen. 

 
 
3.3 Informatiestromen binnen het “Verkeersjournaal” 
 
De volgende partijen zijn officieel betrokken bij het “Verkeersjournaal”: 

 Gemeente Den Haag Dienst Stadsbeheer 
 Gemeente Den Haag Dienst Stedelijke Ontwikkeling 
 Stadsgewest Haaglanden 
 HTM Personenvervoer NV 
 Radio TV West 

 
De eerste drie genoemde partijen betalen aan Radio TV West voor het maken van het “Verkeersjournaal” 
en Radio TV West betaalt een bedrag per uur aan Stadsgewest Haaglanden voor extra werkzaamheden 
ten behoeve van het door Radio TV West vervaardigen van kaarten. HTM Personenvervoer NV is bereid de 
voor het programma benodigde informatie met betrekking tot het openbaar vervoer in de regio te leveren en 
zal in die hoedanigheid ook meewerken aan het programma. De partijen leveren verder een bijdrage in de 
vorm van het ter beschikkingstellen van financiële middelen, diensten dan wel faciliteiten en vanuit de 
diverse partijen participeren verschillende personen in het programma. 
 
Om het programma te kunnen maken vinden vele activiteiten plaats, de activiteiten zijn in het 
stroomschema van Figuur 1 gezet. In de toekomst is het de bedoeling dat de wegbeheerders hun 
informatie gecodeerd aanleveren, nu is dat nog niet het geval. Bij Haaglanden (Bureauredacteur 2) is 
daarom de taak coderen geplaatst, zodat de kaarten verder wel op de toekomstige manier gemaakt 
worden. Omdat dat coderen tijd kost en karteren ook anders kan, is voorlopig besloten deze stap samen te 
voegen met de functie van “Bureauredacteur 3” en Haaglanden alleen te vragen, de omleidingen te 
bekijken en indien nodig aan te passen. 
 
Volgens de overeenkomst die de vertegenwoordigers van de participerende partijen gesloten hebben, zal 
eind april 2004, mede op basis van een representatieve enquête en kijkcijfers, een evaluatie van het 



 

  17 

programma en de gemaakte afspraken plaats vinden. Radio TV West zal de daarvoor benodigde informatie 
tijdig beschikbaar stellen. 
In december 2003 is ook al een enquête gehouden, er waren bijna 300 respondenten en oordelen waren 
veelal positief. Als verbeterpunten gaven respondenten antwoorden als: Meer informatie over 
werkzaamheden buiten Den Haag, meer en langere uitzendingen en meer up-to-date informatie. De 
belangrijkste conclusies, die uit de resultaten van de enquête getrokken kunnen worden, zijn: 

 Het programma wordt door een groot deel van de ondervraagden als goed tot zeer goed beschouwd; 
 Een groot deel van de ondervraagden kijkt minimaal vier keer per week naar het “Verkeersjournaal”; 
 Relatief weinig kijkers maken gebruik van de informatie die op internet en teletekst voorhanden is; 
 De presentatie door Kirsten van Dissel wordt over het algemeen zeer gewaardeerd; 
 Van de ondervraagden kijkt het overgrote deel voor informatie over autoverkeer en het openbaar 

vervoer. 
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Figuur 1: Informatiestromen bij het “Verkeersjournaal” 
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4 De stageopdracht 
 
Dit hoofdstuk beschrijft het doel van de stage en de context waarin deze zich afspeelt (4.1), samen met een 
gedetailleerde beschrijving van de opdracht (4.2) en de beoogde werkwijze (4.3), vormt dit het stageplan. 
 
 
4.1 Doel van de stage en de context 
 
Het uiteindelijke doel van een stage is het gedurende 3 maanden werken bij een dienst of bedrijf. Dit houdt 
in: het werken in een echt bedrijf, het leren kennen van mensen en werkwijzen, maar ook het zelfstandig 
uitvoeren van een onderzoek voor het betreffende bedrijf. In veel gevallen is dit bedrijf werkzaam op 
geodetisch terrein, maar dit is niet verplicht, zolang de stage zich wel op geodetisch terrein bevind. 
 
In onderstaand kader is de beschrijving van de stageplaats weergegeven, zoals deze destijds door Radio 
TV West is opgesteld. 
 
 
Beeldscherm kartografie en GIS bij Radio TV West 
Radio TV West brengt met het “Verkeersjournaal” het laatste nieuws over verkeer en mobiliteit in de regio Haaglanden. Daarbij worden de 
regionale knelpunten voor automobilisten, fietsers en andere weggebruikers in kaart gebracht. Tot nu toe gebeurt dat door vormgevers, die 
telkens weer alle benodigde gegevens moeten verzamelen om deze vervolgens goed in beeld te brengen. Een bewerkelijk proces. Bij Radio TV 
West bestaat dan ook het idee om hiervoor een GIS in te zetten en de mogelijkheden daarvan ten volle te benutten. Hiervoor zoeken zij een 
afstudeerder of eventueel een stagiair. 
 Het doel van deze opdracht is om het gehele geo-informatievoorzieningsproces van de aankondiging van wegopbrekingen en evenementen 
tot aan de uiteindelijke visualisatie op TV letterlijk in beeld te brengen. Een zeer uitdagende opdracht. Zeker als je je bedenkt dat het gehele scala 
van ruimtelijke visualisatiemogelijkheden mag worden open getrokken. Denk daarbij aan de inzet van luchtfoto’s, remote sensing beelden en 
dynamische 3D-animaties. En het eindresultaat kent een groot publiek! 

 
 
De stage zal plaatsvinden binnen vier afdelingen van Radio TV West, namelijk de redactie, vormgeving en 
later ook de afdeling automatisering en de webredactie, in eerste instantie ten behoeve van het 
televisieprogramma het “Verkeersjournaal” en daarna ook voor andere programma’s. Het 
“Verkeersjournaal” wordt één keer per week opgenomen en beschrijft in dagelijkse uitzendingen 
wegwerkzaamheden, wegafsluitingen en bijbehorende omleidingen. 
 
 
4.2 Beschrijving van de stageopdracht 
 
Na gesprekken over het doel van deze stage en over het bedrijf zelf, is de stageopdracht opgesteld. De 
opdracht is in de loop van het onderzoek nog iets gewijzigd, de actuele opdracht is onderstaande, deze is 
opgesplitst in drie delen: 

 Het werkproces, voor het samenvoegen van data in ArcGIS 8 ten einde een kaartje te krijgen voor het 
“Verkeersjournaal”, in beeld brengen en het schrijven van een werkwijze, zodat iemand intern het over 
kan nemen in de toekomst. Dit onderdeel gaat in overleg met Rob Gieb, die deze taak vanuit 
Haaglanden uitvoert. 

 Het onderzoeken van de toepassing van GIS technologie in de nieuwsomgeving. In het AD en de 
Haagsche Courant staan regelmatig mooie voorbeelden, het is uiteindelijk de bedoeling om serieuze 
infographics te maken van actuele zaken voor bijvoorbeeld het journaal. 

 Op zoek gaan naar meer (technische) ontwikkeling, bijvoorbeeld GIS in combinatie met luchtfoto’s of 3D 
informatie. De kosten van data zou bij dit onderdeel geen probleem mogen zijn. 

 
 
4.3 De werkwijze 
 
Na overleg met diverse partijen, is het van groot belang het softwarepakket ArcGIS 8 zo snel mogelijk 
onder de knie te krijgen en een uitgebreide werkbeschrijving te maken, welke te vinden is in de Appendix: 
Werkbeschrijving ArcGIS 8. Als basis is deze werkbeschrijving goed te gebruiken door toekomstige 
kaartenmakers, maar ze is niet volledig, omdat het onmogelijk bleek ook alle uitzonderingssituaties te 
beschrijven en omdat de techniek nog in ontwikkeling is. 

Verdiepen in literatuur over GIS in de journalistiek is ook belangrijk, daarnaast is het nodig informatie in 
te winnen over het afbeelden van kaarten op internet, het bouwen van een internetsite en informatie over 
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de vormgeving voor de televisie, deze kennis is zeer specialistisch en voor een groot deel al in bezit van 
Radio TV West. 

Het in de praktijk brengen van alle opgedane kennis is even zo belangrijk. Het is de bedoeling om zo 
snel mogelijk het maken van de kaarten over te nemen van Rob Gieb, standaard bestanden te maken en 
het proces zo veel mogelijk te automatiseren. 

Infographics in het nieuws zijn alleen nuttig indien ze ook een bijdrage leveren aan de 
informatieoverdracht. Dit betekent dat wanneer er nieuws is wat een infographic kan gebruiken, de 
informatie en de wensen van de verslaggever goed en duidelijk aangeleverd moeten worden. 
Verslaggevers moeten daarom bekend worden gemaakt met de infographics-redacteur en zijn of haar 
mogelijkheden. Dit proces moet min of meer natuurlijk verlopen en is een kwestie van uitproberen en 
testen. 

Omdat de theorie en de praktijk niet gelijk zijn en geld in de periode waarin de stage valt weldegelijk een 
rol speelt, is het waarschijnlijk niet eenvoudig een betere ondergrond te vinden, een oplossing hiervoor zou 
moeten worden gevonden in de kleurkeuze en de standaardisering en opmaak van de kaarten. Ook moet 
gekeken worden wat de mogelijkheden zijn voor het publiceren van kaarten, al dan niet interactief, op het 
internet. 
 
De stageopdracht is uitgevoerd volgens bovenstaande werkwijze, de resultaten zijn in de volgende 
hoofdstukken beschreven. 
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5 Theorie van de journalistieke kartografie 
 
Dit hoofdstuk geeft het theoretisch kader van de kartografie weer. Paragraaf is een 5.1 samenvatting van 
het GIS-kartografie dictaat (van der Schans, 1999) en paragraaf 5.2 geeft een samenvatting van een 
relevante publicatie van de School voor Journalistiek (Verwey, 2003). 
 
 
5.1 GIS-Kartografie 
 
GIS-Kartografie is, zoals het woord zegt, een combinatie van de woorden: 

 GIS staat voor Geografische Informatie Systeem. Dit is een systeem voor het opslaan, controleren, 
integreren, manipuleren, analyseren en weergeven van geografische informatie, bestaande uit een 
bestand met aanduidingen van de posities en eigenschappen van de gegevens en de benodigde op de 
analyse gerichte programma’s (Kartografisch Woordenboek 10.1.19). 

En 
 Kartografie is het geheel van wetenschappelijke, technische en artistieke activiteiten gericht op de 

vervaardiging en het gebruik van kartografische producten. Opmerking: in dit verband moet men niet 
alleen denken aan kaarten, maar ook aan kaartverwante afbeeldingen en kartografische bestanden 
(Kartografisch Woordenboek 1.1.1). 

 
In de kartografie wordt onderzocht, hoe je de ruimtelijke gegevens het best zichtbaar maakt voor een 
bepaalde toepassing. Het blijft dan niet alleen bij “passief” kijken, maar door middel van kaartbeelden kan 
ook interactief in de onderliggende digitale bestanden worden ingegrepen, bijvoorbeeld bij ruimtelijk 
ontwerp in de stedenbouw. Naast kaarten zijn er nog andere vormen waarmee gegevens over ruimtelijke 
verschijnselen kunnen worden gerepresenteerd, bijvoorbeeld platte tekst, tabellen, diagrammen, foto’s en 
geluiden. Al deze vormen worden door GIS ondersteund, maar horen oorspronkelijk niet tot de kartografie. 
Nu steeds meer, en daarom worden in het vervolg onder GIS vooral de digitale vastleggings- en 
bewerkingsprocessen begrepen, en onder kartografie de visuele middelen en processen om de gegevens 
en bewerkingsprocessen toegankelijk en hanteerbaar te maken. Trefwoorden hierbij zijn visualisatie en 
interactie. Ook gecombineerd: interactieve visualisatie om dezelfde gegevens op vele verschillende 
manieren te kunnen bekijken, en visuele interactie om, via kaartbeelden, de onderliggende gegevens te 
kunnen veranderen bij inwinning, mutatie en ontwerp. 

Ruimtelijke informatie wordt vastgelegd, bewerkt en gepresenteerd ter ondersteuning van het menselijk 
handelen in de wereld. GIS en Kartografie zijn beide gericht op de informatieverzorging ten behoeve van dit 
handelen. De weergave van de onderdelen van het informatieverzorgingsproces berust op een schema dat 
rond 1990 is ontwikkeld: het WDGM-model. Alle mogelijke deelprocessen bij geo-informatieverzorging 
vinden hierin plaats. Ze zijn te ordenen in een cirkelvormig diagram, met aan de buitenkant de wereld (W) 
en de mens (M), en daartussenin de (zichtbare) grafische (G) voorstellingen en de (onzichtbare) digitale (D) 
modellen.  

 
 

 
Figuur 2: Het WDGM-model – cirkelvormig 

(Van der Schans, 1999) 



 

22 

Ook is er een onderverdeling te maken binnen de digitale modellen, te weten een digitaal landschaps- of 
terreinmodel en een digitaal visualisatie- of kaartmodel: 

 Een digitaal landschaps- of terreinmodel (DLM of DTM) beschrijft een landschap en wat daarin voorkomt 
of gebeurt als terreinobjecten, met terreingeometrie en thematische terreinattributen, geheel ongeacht 
hun eventuele grafische weergave. Het bestaat uit gedachte-inhouden. 

 Een digitaal visualisatie- of kaartmodel (DVM of DKM) beschrijft een kaart of ander visualisatiemedium 
als grafische beeldobjecten (stippen, strepen, vlekken, letters), met beeldgeometrie en kleuren of 
grijswaarden, ongeacht wat het allemaal voorstelt. Het bestaat uit uitdrukkingsvormen. 

 
Bij het “Verkeersjournaal” wordt vooral gewerkt aan het digitale visualisatiemodel ten einde zo goed en 
duidelijk mogelijke plaatjes voor de televisie te maken. Eis voor alle kaartjes is eenvoud, helderheid en 
donkere kleuren. Het blijkt dat de plaatjes veel lichter op de televisie komen, dan dat ze gemaakt zijn. Voor 
een deel zal dit liggen aan de instellingen van het beeldscherm waarop ze gemaakt zijn, maar voor een 
deel ligt het ook aan het feit dat bij de omzetting van de digitale beelden naar televisiebeelden op een 
standaard kleuren televisie, veel informatie en kleur verdwijnt. Hiermee moet dan ook rekening worden 
gehouden. 
 
 
5.2 De journalistieke praktijk 
 
In de wereld van de nieuwe media bestaan twee typen verslaggeving: nieuws volgend en nieuws makend, 
in het Engelse jargon aangeduid als re-active en pro-active reporting. Het eerste type is algemeen 
standaard in de journalistieke werkwijze, bij het tweede type verslaggeving ligt de nadruk niet op het 
verslaan van gebeurtenissen, maar op het maken of ontdekken van nieuws of trends. 

Ook bij de toepassing van kaarten is dit onderscheid te maken. Kaarten die alleen dienen als illustratie 
en gegevens samenvatten, horen meer bij het eerste type verslaggeving. Wanneer kaarten en GIS gebruikt 
worden voor het analyseren van data met het doel nieuwe patronen te vinden, dan sluit dit meer aan bij 
‘nieuws maken’ of pro-active reporting. GIS is bij uitstek geschikt voor de onderzoeksjournalistiek. 

Talloze onderwerpen lenen zich voor de nieuws makende benadering, zeker voor de regionale media 
zijn er belangwekkende onderzoeksprojecten. De adders onder het gras zijn de beschikbaarheid van data 
en de training van redacteuren die met de nieuwe technieken kunnen omgaan. Twee problemen spelen bij 
de training een rol: 

 Het omgaan met cijfers, het rekenen en werken met statistiek is bij de meeste journalisten 
onderontwikkeld. 

 Journalisten zijn onbekend met het analyseren en begrijpen van geografische patronen. Ze moeten 
leren geografisch te denken, wanneer nieuws een ruimtelijke dimensie heeft. 

Journalisten zullen in de toekomst op de hoogte moeten zijn van het gebruik van GIS en kaartensoftware, 
maar dit veronderstelt tegelijkertijd enige kennis van databases en spreadsheets. Ervaring leert dat het 
trainen van journalisten door computerdeskundigen en geografen, niet werkt. Journalisten willen kennis die 
direct past in hun vak en werkwijze. 
 
Hoe moet het dan wel? Traditioneel bestaat er bij de productie van een medium (krant, televisie, website) 
een scheiding tussen de schrijvende redactie en de infographics-redacteuren en vormgevers, maar met de 
komst van GIS en spreadsheets kunnen redacteuren achter hun bureau zelf de grafieken en kaarten bij hun 
artikelen maken. Zoals tekst en beeld integreren op het web, zien we ook op de redacties een nauwere 
band ontstaan tussen de schrijvende redactie en infographics. De diverse media hebben verschillende 
oplossingen voor het probleem bedacht: 

 De productie van de kaarten voor “Nederland kiest” is volledig uitbesteed aan een bedrijf (ESRI). 
 Bij het “NRC Handelsblad” is sprake van een integratie van GIS in de dagelijkse nieuwsproductie. 
 Een tussenvorm is te vinden bij het “Algemeen Dagblad”, “Utrechts Nieuwsblad”, “Dagblad van het 

Noorden” en nu ook bij “Radio TV West”, waar de productie van kaarten vooral in handen van de 
infographics-redactie is. De kennis is dan wel in huis, maar de schrijvende redactie gebruikt het niet 
direct. 

Een andere mogelijkheid, die nog nergens uitgewerkt is, is het plaatsen van GIS bij de vormgeving. 
Vormgevers moeten voor deze nieuwe taak worden opgeleid, want ze kunnen mooie plaatjes maken, maar 
hebben geen kaas gegeten van databases en spreadsheets. Infographics-redacteuren hebben echter wel 
kennis van GIS en spreadsheets, maar moeten getraind worden in het afbeelden van informatie voor een 
bepaald medium. 
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6 Infographics bij TV West 
 
Dit hoofdstuk is het belangrijkste gedeelte van dit stageverslag. Het beschrijft de resultaten naar aanleiding 
van de stageopdracht, paragraaf 6.1 behandelt het maken van plaatjes voor het “Verkeersjournaal”, 
paragraaf 6.2 vermeldt het gebruik van afbeeldingen in bijvoorbeeld het journaal en de laatste paragraaf 
gaat in op het maken van onder andere een website ten behoeve van het “Verkeersjournaal”. 
 
 
6.1 het “Verkeersjournaal”, de basis 
 
Het huidige proces van het maken van het programma begint met een vergadering op maandag, waar alle 
wegwerkzaamheden (incidenten) bij elkaar komen en tekst en uitleg wordt gegeven. De dinsdag daarop 
wordt uitgezocht welke straten afgesloten zijn en hoe de omleidingen precies lopen, woensdags worden de 
kaarten gemaakt, deze moeten woensdag aan het eind van de dag klaar zijn. 

De kaarten die bij de huidige uitzendingen gebruikt worden, zijn opgebouwd uit verschillende 
ondergronden en data, de ondergronden moeten actueel en legaal verkregen zijn. De volgende lagen zijn 
hiervoor in gebruik: 

 CBS Grondgebruik 
 Bedrijfsterreinen in Haaglanden 
 Kantoorgebieden in Haaglanden 
 Alle gemeenten in Haaglanden 
 Alle gemeenten in Zuid-Holland 
 Laag waarin het uitzendgebied staat aangegeven 
 Nieuwbouw locaties ten oosten van Delft 
 Laag waarin het uitzendgebied staat aangegeven (Haaglanden) 
 Teleatlas hoofdwegen in Zuid-Holland 
 Deelplannen op de Vinexlocaties in het uitzendgebied 
 Vinexlocaties in het uitzendgebied 
 Nationaal Wegen Bestand blad Zuid-Holland 
 Alle OV-lijnen in het uitzendgebied 
 Alle spoorlijnen in en door Zuid-Holland 
 Alle NS-stations in Zuid-Holland 
 Het traject van de HSL door Zuid-Holland (tot Rotterdam) 
 kader.dbf 
 incident.dbf 
 incident_vlakken.dbf 
 [straatnaam][gemeente][weeknummer][volgnummer].dbf 

1998 
2000 
2000 
2000 
2000 
2000 
2000 
- 
2003 
2000 
2000 
2003 
2004 
2003 
- 
- 
iedere week vernieuwd 
iedere week vernieuwd 
iedere week vernieuwd 
iedere week vernieuwd 

 
Er bestaan twee methoden om de kaarten te produceren, bij de eerste methode wordt het bestand 
“[straatnaam][gemeente][weeknummer][volgnummer].dbf” gebruikt en bij de tweede wordt alle informatie 
ingevoerd in het bestand “incident.dbf”. In onderstaand kader worden beide methoden behandeld. 
 
 
Twee methoden om kaarten te maken 
 
Kaarten maken met behulp van “[straatnaam][gemeente][weeknummer][volgnummer].dbf” 
Wegbeheerders of gemeenten leveren voor alle werkzaamheden die zij in het “Verkeersjournaal” behandeld willen worden, een bestand aan. Dit 
bestand is de tabel “[straatnaam][gemeente][weeknummer][volgnummer].dbf” en hierin staan alle wegvakken die iets met de werkzaamheden te 
maken hebben en welke functie zij hebben, de kolomindeling is te vinden in Bijlage 4: Tabellen, Tabel 1. Op de redactie van Radio TV West wordt 
de tabel gekoppeld aan het Nationaal Wegen Bestand en afgebeeld met behulp van “ArcMap” van “ESRI”. 

Op dit moment is het voor de wegbeheerders en de gemeenten nog niet mogelijk deze tabel te maken, maar in de toekomst is het wel 
degelijk de bedoeling dat de wegbeheerder of een medewerker van de betreffende gemeente de tabel zelf maakt met het daarvoor bestemde 
programma: “Wegkenmerken+” van de afdeling “AVV” van “Rijkswaterstaat”. Dit programma is ingewikkeld en voor de uiteindelijke tabel is ook 
nog een programma (zoals Microsoft Access) nodig dat een mdb-bestand kan lezen en bewerken. 

Omdat dit alles dus nog niet mogelijk is, is afgesproken dat het maken van deze tabel wordt uitbesteed aan “Haaglanden”. Dit heeft tijdelijk zo 
gewerkt, maar is een zeer omslachtige werkwijze en het is ook niet mogelijk gebleken dit op de redactie uit te voeren, daarom wordt deze 
methode voorlopig niet gebruikt en worden de gegevens rechtstreeks in de laag “incident.dbf” ingebracht. 
 
Informatie rechtstreeks invoeren in ”incident.dbf” 
Binnen het programma “ArcMap” bestaat de mogelijkheid om wijzigingen in een laag aan te brengen en om nieuwe informatie in te voeren in een 
nieuwe laag. Van deze functie wordt gebruikgemaakt bij deze methode en worden de betrokken straten als het ware op de kaart gezet. 
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Wanneer minstens één methode goed is uitgevoerd, kunnen er twee tot vijf kaarten geproduceerd worden 
met behulp van alle andere lagen en de laag “kader.dbf”, waarmee een rood kader om de locatie wordt 
afgebeeld. De eerste kaart is in de meeste gevallen ingezoomd tot een schaal 1:8.000, op deze kaart is de 
afgesloten weg te zien. De volgende kaarten geven de omleidingen weer, voor achtereenvolgens auto’s, 
openbaar vervoer en fietsers. De laatste kaart geeft een overzicht van de regio met een rood kader, om de 
locatie aan te geven, deze kaart moet apart gemaakt worden evenals het rode kader zelf en wordt als 
eerste kaart in de uitzending getoond om ongeveer aan te geven waar in de regio de werkzaamheden 
plaatsvinden. Voorbeelden zijn te vinden in Figuur 3 t/m Figuur 6. 
 
 

 
Figuur 3: Detailkaart 1 – incident 

 
Figuur 4: Detailkaart 2 - omleiding auto’s 

 
Figuur 5: Detailkaart 3 - omleiding OV 

 
Figuur 6: Detailkaart 4 - omleiding fietsers (1) 

 
Figuur 7: Overzichtskaart 

 
Figuur 8: Detailkaart 4 - omleiding fietsers (2) 

 
 
In het geval van bovenstaand voorbeeld, is de Javastraat (midden in Den Haag) voor een deel afgesloten. 
Voor auto’s, trams, bussen en fietsers geldt een omleiding, deze is tamelijk eenvoudig. 

Door het medium televisie worden de kaarten minder scherp en vervagen de kleuren. Uit Figuur 6 blijkt 
dat de gele letters van de straatnamen niet goed te zien zijn, het is daarom is naar een andere kleur 
gezocht. Een alternatief is te zien in Figuur 8. Dit alternatief is ook niet ideaal, maar omleidingen voor 
fietsers komen gelukkig niet al te vaak voor. 
 
Alle informatie, waaronder het rode kader, staat op ieder figuur aan de linkerkant afgebeeld, omdat de 
presentatrice aan de rechterkant voor de kaart staat. Het idee achter het rode kader was dat de 
presentatrice op het kader in de overzichtskaart (Figuur 7) zou “klikken” en dat dan de tweede kaart 
verscheen, dan wordt het een soort interactieve uitzending. Dit idee is echter al snel achterwege gelaten, 
omdat het niet mogelijk was dit visueel te maken en omdat dat er op televisie, volgens deskundigen, 
onprofessioneel uit ziet. 

Wanneer de kaarten klaar zijn, maakt de vormgever een lay-out (zie Figuur 15) om de kaart en verkleint 
het geheel tot televisiebeeldformaat. Dan zijn de kaarten klaar om uitgezonden te worden. 
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6.2 Infographics bij andere programma’s 
 
Deel twee van de stage bestaat uit het onderzoeken van de toepassing van GIS technologie in de 
nieuwsomgeving, in het "Algemeen Dagblad" en de "Haagsche Courant" staan regelmatig mooie 
voorbeelden, het is uiteindelijk de bedoeling om serieuze infographics te maken van actuele zaken voor 
bijvoorbeeld het journaal en bij andere programma’s. Een probleem hierbij is dat dit bij Radio TV West niet 
te plannen is, want de meeste onderwerpen die in het nieuws worden behandeld dienen zich op de dag zelf 
aan en Radio TV West maakt geen pro-active reportages Het belangrijkste is dat redactieleden je weten te 
vinden en zelf bedenken of ze een kaartje kunnen gebruiken bij hun onderwerp. Probleem hierbij is dat er 
dan iedere dag iemand moet zijn die de kaartjes kan maken, dat het maken van kaartjes haastwerk is en 
dat gedetailleerde informatie vaak ontbreekt. 

Voor dit deel van de stageopdracht is geen echt onderzoek uitgevoerd. Iedere keer wanneer er een 
onderwerp een kaart nodig had, is deze gemaakt aan de hand van de beschikbare informatie en eventueel 
extra aangevraagde informatie bij de betreffende gemeente. In de periode oktober tot maart hadden vijf 
onderwerpen een kaart en na die tijd nog twee. (zie Bijlage 6: Infographics bij andere programma’s en 
Figuur 9) De eerste keer was het meer een soort experiment, de rest werd door de redactieleden zelf 
aangedragen. 
 
 

 
Figuur 9: Resultaat experiment "Brand in Delft" 

 
 
Om in het vervolg het maken van de kaarten nog soepeler te laten lopen, kan over een aantal zaken van 
tevoren worden nagedacht en kunnen een aantal zaken al voorbereid worden, bijvoorbeeld: het maken van 
een standaard bestand met de lengtebreedte verhouding 4:3, dat naar eigen voorkeur kan worden 
aangepast en het verzamelen van telefoonnummers van GIS-specialisten bij de gemeenten in de regio, in 
Bijlage 3: Telefoonnummers van gemeenten, is een begin gemaakt. Verder is het verstandig om bij het 
maken van een kaartje aan de betreffende redacteur duidelijk te vragen wat hij of zij verwacht en wat de 
exacte situatie is. 
 
 
6.3 Vernieuwing en automatisering 
 
Deel drie van de stage is het op zoek gaan naar meer (technische) ontwikkeling, bijvoorbeeld GIS in 
combinatie met luchtfoto’s of 3D informatie. Een voorbeeld hiervan is het gebruik van remote sensing 
beelden bij de verslaggeving van de oorlog in Irak. Eenvoudiger kan ook, door bijvoorbeeld de kleuren van 
de huidige ondergrond te veranderen of andere data gebruiken. De kosten van de ontwikkeling zouden bij 
dit onderdeel geen probleem mogen zijn, maar uit hoofdstuk 2 mag worden opgemaakt worden, dat dit niet 
de realiteit is, goedkope oplossingen hebben daardoor de voorkeur. 
 
Via de website van TerraDesk is het mogelijk luchtfoto’s te bekijken van het centrum van Den Haag, maar 
omdat het vrij lastig bleek informatie uit deze luchtfoto’s te halen en luchtfoto’s geld kosten, is de 
mogelijkheid om luchtfoto’s te gebruiken voor “ Het Verkeersjournaal” niet verder uitgewerkt. 

Op andere manieren is wel naar vernieuwing gezocht, zo zijn in de loop van de tijd de kleuren donkerder 
gemaakt en is het datapakket uitgebreid en het Nationaal Wegen Bestand is vernieuwd. Om de informatie 
op de TV nog beter zichtbaar te maken is een begin gemaakt met een heel nieuw kleurenbeeld, de kleuren 
zijn hierbij uitgekozen aan de hand van de kaart van de gemeente Den Haag door “Falkplan”, een 
impressie hiervan in onderstaande afbeelding. 
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Figuur 10: Zoetermeer in de nieuwe kleuren 

 
 
Omdat het informatievoorzieningsproces nogal rommelig verloopt, is van de kant van het “Stadsgewest 
Haaglanden” het idee geopperd een grote database op te zetten die door de wegbeheerders gevuld kan 
worden en waar de anderen informatie uit kunnen halen om deze vervolgens te presenteren. In 
onderstaand kader wordt dit idee uiteen gezet en uitgewerkt. 
 
 
Informatievoorziening in een nieuw jasje  
De website van Radio TV West brengt met het gedeelte het “Verkeersjournaal” het laatste nieuws over verkeer en mobiliteit in de regio 
Haaglanden. Daarbij worden de regionale knelpunten voor automobilisten, fietsers en andere weggebruikers in kaart gebracht.  
 
Hoe ziet dat er uit? 
Op de website van Radio TV West kunnen bezoekers op het gedeelte van het “Verkeersjournaal” informatie lezen over de locaties waar gewerkt 
wordt en wat de directe gevolgen hiervan zijn voor de omwonenden en welke omleidingsroutes gelden. Zij kunnen dan doorklikken naar 
afbeeldingen van kaarten om de situatie te verduidelijken. 
 
Hoe komt het zo ver? 
Wanneer wegbeheerders hun werkzaamheden aan melden bij het “Verkeersjournaal” maken zij met behulp van het computerprogramma 
“Wegkenmerken+” van de afdeling “AVV” van “Rijkswaterstaat” een aantal bestanden waarin staat aangegeven welke weggedeelten zijn 
afgesloten en van welke omleidingsroutes gebruik gemaakt gaat worden. Ook maken zij een tekstuele beschrijving van de werkzaamheden, het 
doel en de gevolgen. Zij geven hierbij ook duidelijk aan voor wie welke omleidingen gelden. 
 
Hoe verder? 
Medewerkers van het “Verkeersjournaal” verzamelen alle bestanden en koppelen deze in een GIS aan andere geoinformatiebestanden. Dit 
programma berekent vervolgens voor ieder werk de meest omvattende rechthoek, het centrum hiervan en de schaal waarop de kaart moet 
worden afgebeeld. Aan de hand van afbeeldingsregels, de schaal en de bestanden met omleidingen worden vervolgens de verschillende kaarten 
gegenereerd. De gegenereerde kaarten kunnen zowel voor het internet als de televisie uitzendingen gebruikt worden, hetzij verkleind, hetzij 
verder bewerkt. 
 
En dan op het internet? 
De tekstuele beschrijving van de werkzaamheden worden, na correctie, samen met de namen van de kaarten in een database gezet en vanuit 
deze database wordt de website gevuld. 
 
Wat is hier voor nodig? 

 De medewerking van alle wegbeheerders en/of gemeenten die mee willen doen, zij moeten tevens in bezit komen van “Wegkenmerken+” en 
ook van “Microsoft Access”. 

 Een locatie voor de database, de website en de kaarten, die van af de redactie van Radio TV West bereikbaar is, de website en de database 
moeten kunnen worden bijgehouden door een redacteur.  

 De benodigde computerprogramma’s, deze moeten verkregen worden en de redacteur moet over de nodige computertechnische kennis 
beschikken. 

 De gebruiksklaar geprogrammeerde de database, de GIS, de functies en de website. 
 Een contract waarin alle afspraken zijn vastgelegd en waar alle partijen aan zijn gebonden. 

 
 
Gedurende de stageperiode en de aansluitende tijd hebben enkele experimenten plaats gevonden, maar 
daarbij zijn ook diverse problemen opgetreden. Zo is er een website gebouwd, deze werd gevuld met 
informatie uit een Accesdatabase. In theorie was het mogelijk deze database te benaderen vanaf iedere 
willekeurige computer met internetaansluiting, maar de praktijk bleek anders, de computer moest namelijk 
beschikken over een bepaalde invoegtoepassing en “Microsoft Windows XP” en aan de kant van de server 
moesten bepaalde instellingen worden veranderd, om de database te kunnen benaderen, dit bleek niet 
mogelijk. Figuur 11 toont het gedeelte van de website, dat voor iedereen zichtbaar is en Figuur 12 toont het 
invulscherm, dat alleen toegankelijk is voor medewerkers. 
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Figuur 11: Het invulscherm op de website 

 
 

 
Figuur 12: De website voor bezoekers 

 
 
Verder is op de redactiecomputer “Wegkenmerken+” geïnstalleerd, maar de benodigde “Microsoft Access” 
is niet beschikbaar bij Radio TV West. 
 
In het begin bestond er het idee om de kaarten met hulp van bijvoorbeeld “ArcIMS” van “ESRI” interactief 
toegankelijk te maken, hier is mee geëxperimenteerd, maar ook hier bleek het resultaat niet bevredigend te 
zijn en dat het up-to-date houden van de informatie en de kostprijs van het programma in de toekomst een 
probleem zouden gaan vormen. In Figuur 13 het eindresultaat van de kaart met “ArcIMS”, is te zien is dat 
de afgesloten straten en bijbehorende omleidingen niet zijn opgenomen in de kaart, dit komt omdat het niet 
mogelijk bleek, met behulp van begin- en einddata enkel de gegevens weer te geven die representatief zijn 
voor een bepaalde periode. Verder kon ook de aanvullende tekstuele informatie niet op de gewenste 



 

28 

manier op basis van de kaart worden weergegeven en is de huidige server te traag voor de benodigde 
data, waardoor het laden van data lang duurt en in het ergste geval een time-out wordt gegeven. 
 
Het is ook een probleem dat Radio TV West maar één internetredacteur heeft, die geen tijd heeft voor en 
geen zin heeft in “onnodig” werk. 
 
 

 
Figuur 13: De website met ArcIMS 
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7 Mijn ervaringen 
 
In dit laatste hoofdstuk zijn mijn ervaringen met betrekking tot deze stage te vinden. Paragraaf 7.1 start met 
de doelstellingen van de stage in het algemeen en mijn reactie daarop, in paragraaf 7.2 vervolgens een 
beschrijving van de begeleiding die ik binnen Radio TV West had en de problemen die daarbij kwamen 
kijken. De derde paragraaf vertelt over het niveau en het nut van de stage, deze paragraaf is belangrijk, 
want ook hier heb ik problemen ondervonden. Vervolgens in de paragraaf daarna (7.4) mijn mening over de 
resultaten die ik heb geboekt en tot slot mijn visie op de toekomst in de laatste paragraaf (7.5). 
 
 
7.1 Doelstellingen stage 
 
Volgens Artikel 2 van de Stageregeling 5-jarig studieprogramma (2003) wordt onder de doelstellingen van 
de stage verstaan: 
1. De in de eerste drie studiejaren opgedane theoretische en praktische kennis toepassen en toetsen in de 

praktijk, waarmee een bijdrage wordt geleverd aan de verwerking van de leerstof en een betere basis 
wordt verkregen voor het afstuderen. 

2. Het opdoen of vergroten van vaktechnische ervaring, bedrijfsorganisatorisch inzicht en andere (sociale) 
vaardigheden. 

3. Het bieden van de gelegenheid (uitgebreid) kennis te maken met de (geodetische) beroepspraktijk. 
 
Dit wil zeggen dat de stage een combinatie is van het werken in een bedrijf en alles wat daarbij komt kijken 
en eerder opgedane kennis toepassen, verder biedt stagelopen de mogelijkheid de beroepspraktijk, al dan 
niet geodetisch te verkennen. 

Gedurende mijn stage zijn niet alle doelstellingen even goed bereikt. Door de financiële problemen 
binnen Radio TV West was het mogelijk inzicht te krijgen in de bedrijfsorganisatie, doordat mijn werkplek op 
de redactie, werd het mij makkelijk gemaakt mensen te ontmoeten en mijn sociale vaardigheden verder te 
ontwikkelen. Omdat “ESRI” de software bij Radio TV West heeft gebracht en er veel is samengewerkt met 
de partners bij “Haaglanden” en de gemeente Den Haag, heb ik de gelegenheid gekregen kennis te maken 
met de geodetische beroepspraktijk, maar meer buiten dan binnen Radio TV West. Op het niveau en 
daarmee de geslaagdheid van de eerste doelstelling kom ik in paragraaf 7.3 terug. 
 
 
7.2 Introductie en begeleiding binnen Radio TV West 
 
Na een introductiegesprek met Toon Lampe voor het begin van de stage en een bezoek aan de GIS 
Conferentie 2003 ben ik vol goede moed begonnen. Ik heb kennis gemaakt met de medewerkers van het 
“Verkeersjournaal” en met mijn collega’s op de redactie, verder heb ik voor het eerst de opnames 
meegemaakt. Omdat bekend werd dat alle freelancers zouden worden ontslagen, werden gelijk met mij nog 
twee andere medewerkers ingewerkt voor het “Verkeersjournaal”, hierdoor verliepen de sociale contacten 
tijdens en na de opnames nogal chaotisch, vooral omdat Kirsten slecht werd ingelicht. De eerste twee 
weken zijn buiten dit voorval tamelijk rustig verlopen. Vanuit Radio TV West werd ik op dat moment 
begeleidt door Toon Lampe en voor technische vragen kon ik bij Rob Gieb van “Stadsgewest Haaglanden” 
terecht. 
 
Tijdens de derde week van mijn stage begonnen de problemen, 42 medewerkers kregen te horen dat zij 
per 1 december werden ontslagen en in een soort mobiliteitscentrum zouden worden geplaatst, voor enkele 
van hen was de mogelijkheid gecreëerd om tot februari te blijven, zo ook voor Toon Lampe, maar per 1 
december was ook hij verdwenen zonder enige mededeling. 

Omdat de samenwerking met mijn directe collega bij het “Verkeersjournaal” Mischa van Vlier goed was, 
is het geen probleem geweest korte tijd zonder stagebegeleider te werken, maar per 17 december is Ron 
Fresen, de toenmalige hoofdredacteur, mijn begeleider geworden en met hem heb ik diverse malen 
gesproken over mijn stage. Hij heeft mij de mogelijkheid geboden na mijn stage voor één dag in de week te 
blijven werken bij Radio TV West met bijna dezelfde functie als tijdens de stageperiode. 

Tegen het einde van mijn stage was ook hij verdwenen bij Radio TV West en werd Richard Hogenkamp 
mijn laatste stagebegeleider, maar met hem heb ik nauwelijks over mijn stage gesproken, vooral omdat hij 
met grotere problemen geconfronteerd werd. Op mijn laatste stagedag ontving ik van Mischa, ook namens 
Richard, een grote bos bloemen en zij lieten mij daarbij weten dat ze erg tevreden waren over mijn werk. 
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De begeleiding van mijn stage binnen Radio TV West heeft dus wel eens te kort geschoten, maar ik heb 
niets te klagen gehad en als ik vragen had kon ik altijd wel terecht bij iemand. Rob Gieb heeft mij daarbij 
altijd ook goed geholpen en was er voor de meer technische vragen, tijdens mijn stage heb ik een deel van 
zijn werkzaamheden voor het “Verkeersjournaal” overgenomen. 
 
 
7.3 Niveau en nut van stage 
 
Bij de opzet van deze stageplaats werd gedacht aan een stagiair of afstudeerder, maar gezien de aard van 
de werkzaamheden, was deze opdracht naar mijn mening niet geschikt als afstudeerproject. Ik twijfel zelfs 
of het niveau voldoende is voor een stageplaats voor een student van een universiteit. Door de interne 
problemen bij Radio TV West werd het niveau van de stage als geheel iets verhoogd, maar achteraf gezien 
was dit misschien niet voldoende. De externe proeven met “ArcIMS”, de overname van de werkzaamheden 
van Rob Gieb en het overnemen van de vormgevingswerkzaamheden hebben de stage op een 
aanvaardbaar niveau gebracht. Deze stage is belangrijk geweest voor Radio TV West en met name voor de 
reductie van de kosten voor het “Verkeersjournaal”, omdat ik veel werkzaamheden heb overgenomen van 
duurdere medewerkers, zowel intern als extern. 
 
 
7.4 Over het resultaat 
 
Ik ben eigenlijk een beetje teleurgesteld over wat ik binnen de stageperiode bereikt heb, niet alles is 
volgens plan en naar verwachting verlopen. Radio TV West heeft toch wel grote financiële problemen 
gehad en ik kon niet alles voor elkaar krijgen zoals ik dat zou willen. 

De meeste tegenwerking kreeg ik van de webredacteur toen ik het idee had de kaarten op internet te 
publiceren. Zij vond dat dat te veel werk was, terwijl ik dat ook wel op me wilde nemen, maar ze bleef bij 
haar standpunt. De enige manier om informatie op het internet krijgen, was de informatie te mailen, dan 
controleerde zij het en voerde het in op internet, naar mijn mening is dit omslachtig. Pas drieëneenhalve 
maand na het einde van mijn stage was het mogelijk voor mij de mogelijkheid te maken zelf de informatie 
op internet bij te werken, dat dit zo lang heeft geduurd komt onder meer omdat men was overgestapt op 
een nog niet goed werkende nieuwe website, met alle problemen van dien. In die periode is heel even 
gebruikt gemaakt van e website die ik had ontworpen, maar dat was ineens ook weer voorbij. 

Het werken met “ArcIMS” is me ook tegengevallen evenals het automatiseren van het proces van het 
maken van kaarten. 
 
De reden dat dit rapport zo lang heeft moeten wachten heeft zich in deze en vorige paragraaf verscholen. 
Lange tijd ben ik bezig geweest met het trekken van conclusies uit mijn onderzoek, maar dat was niet goed 
mogelijk. Toen ik er niet uit kwam heb ik bij mijn begeleider van Geodesie geïnformeerd wat te doen, hij zei 
dat het beschrijven van mijn eigen ervaringen meer van belang is. 
 
De uiteindelijke website is te beklijken via: http://www.chappin.com/martine/verkeersjournaal, de webmap 
met “ArcIMS” is te bekijken op: http://webmap.geo.tudelft.nl/website/verkeersjournaal. 
 
 
7.5 Mijn toekomstvisie 
 
Radio TV West heeft mij werk te bieden voor ongeveer één dag in de week, maar ik weet nog niet voor 
hoelang ik dit ga doen. Tijdens dit schrijven is bekend geworden dat het contract met de partners tot 
december 2005 is verlengd, maar dat er nog meer verandering moeten plaatsvinden. De redactie van het 
“Verkeersjournaal” wordt over een hoop beslissingen slecht geïnformeerd en ik hoop dat daar verandering 
in komt. 
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Bijlagen 
 
 
Bijlage 1: Stageplan 
 
Stageplan 
 
De student levert ruim voor de aanvang van de stage een beknopt stageplan ter goedkeuring in bij de sectiebegeleider. Dit plan bevat tenminste 
informatie over de stageperiode, het stageverlenend bedrijf en de interne begeleiding, alsmede de plaats, aard en een inschatting van het niveau 
van de te verrichten werkzaamheden en de naam van de sectiebegeleider uit de afdeling. (Bron: Stageregeling 5-jarig studieprogramma, 
Geodesie) 

 
Stageperiode: 
Vanaf 1 oktober deeltijd (2½ dag in de week), dat wil zeggen dat de periode naar schatting loopt van 1 
oktober 2003 tot en met 31 maart 2004. 
 
Stageverlenend bedrijf: 
RTV West 
Laan van 's Gravenmade 2 Postbus 24025 
Den Haag 2490 AA Den Haag 
Tel: 070-3078888 
 
Interne begeleiding: 
Toon Lampe (van 1 oktober 2003 tot 1 december 2003) Tel: 06-54381207 
Ron Fresen (van 1 december 2003 tot 1 maart 2004) 
Richard Hogenkamp (van 1 maart 2004 tot 1 april 2004) Tel: 070-3078038 (algemene nummer) 
 
Plaats, aard en inschatting van het niveau van de te verrichten werkzaamheden: 
De stage zal plaatsvinden binnen een afdeling van TV West, namelijk de redactie en de vormgeving, ten 
behoeve van het televisieprogramma het “Verkeersjournaal”. Dit programma wordt één keer per week 
opgenomen, maar beschrijft in dagelijkse uitzendingen wegafsluitingen en omleidingsroutes. Binnen het 
bedrijf moet flink bezuinigd worden, dus het is zaak ook te kijken naar de toekomstige kosten die gepaard 
gaan met deze nieuwe ontwikkelingen. 
Opdracht bestaat uit drie delen: 

 het werkproces, voor het samenvoegen van data in ArcGIS 8 ten einde een kaartje te krijgen, in beeld 
brengen en het beschrijven van een werkwijze, zodat iemand intern het over kan nemen in de toekomst. 
Dit onderdeel gaat in overleg met Rob Gieb, die deze taak vanuit “Stadsgewest Haaglanden” uitvoert. 

 het onderzoeken van de toepassing van GIS technologie in de nieuwsomgeving. In “Het Algemeen 
Dagblad” en de “Haagsche Courant” staan regelmatig mooie voorbeelden, het is uiteindelijk de 
bedoeling om serieuze infographics te maken van actuele zaken. 

 opzoek gaan naar meer (technische) ontwikkeling, bijvoorbeeld GIS in combinatie met luchtfoto’s of 3D 
informatie. De kosten van data zouden bij dit onderdeel geen probleem moeten zijn. Een voorbeeld is 
het gebruik van remote sensing beelden bij de verslaggeving van de oorlog in Irak. 

 
Naam sectiebegeleider Geodesie: 
Edward Verbree 
Tel: 015-2782584 
 
 
Bijlage 2: Weekplanning 
 
Planning deel 1 
Week 40: Kennismaking met het bedrijf en met directe collega’s en afspraak met Rob Gieb. 
Week 41: Schrijven “Werkbeschrijving ArcGIS 8” en oefenen met “week34 1.dbf”. 
Week 42: Simultaan kaartjes maken en vergelijken, Rob Gieb codeert en maakt kaartjes en Martine maakt 

ook kaartjes, daarna vergelijken. Contact opgenomen met de internetredactie om de kaartjes op 
de website van Radio TV West te zetten, is niet mogelijk (“te veel werk om alles te ftp-en”). 

Week 43: Werkzaamheden zijn overgenomen, Rob Gieb codeert en Martine maakt kaartjes, vanaf 19 
oktober in uitzending. De werkzaamheden van Martine mogen iedere week maar 1½ dag 
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kosten (dinsdag en woensdagochtend). Zorgen dat de kaartjes iedere week op de juiste plaats 
staan en in het juiste formaat. 

Week 45: Omdat Marc Bos (in week 45) zag aankomen dat hij ziek zou gaan worden, heeft hij Martine op 
dinsdag ingewerkt in Photoshop 7. Woensdag, donderdag en vrijdag was hij inderdaad ziek en 
Martine heeft alle kaartjes van het “Verkeersjournaal” vormgegeven. 

Week 2: Martine heeft in overleg met Rob Gieb, het uitzoeken van de omleidingen op zich genomen, 
hierdoor vervalt het coderen en koppelen van tabellen. 

Week 11: Rob Gieb komt langs om te praten over het vervolg proces, wat hij met de kaarten zou willen en 
om het programma “Wegkenmerken+” te installeren, waarmee Martine in de toekomst tabellen 
kan maken, dit werkt nog niet omdat “Microsoft Access” niet beschikbaar is. 

Week 14: Einde stage. 
 
Planning deel 2 
Week 44: Experiment “Brand in Delft” gestart, kaart gemaakt voor “West Journaal”. Met hulp van Marc 

Bos. 
Week 45: Kaart gemaakt voor “Plannen van de gemeente Leidschendam-Voorburg”. Marc Bos was ziek, 

dus hij heeft er niet naar gekeken. 
Week 46: Kaart gemaakt voor “Tracé Noordelijke Randweg” in de gemeente Leidschendam-Voorburg. 

Marc Bos heeft alleen het kader er omheen geplakt. 
Week 3: Grafiekje gemaakt over de stijging van de toeristenbelasting. 
Week 13: Kaarten gemaakt voor de live-uitzending over de bijzetting van Koningin Juliana in Delft en de 

route daar naar toe door Den Haag. 
Week 14: Einde stage. 
 
Planning deel 3 
Week 45: Geëxperimenteerd met andere kleuren en andere belijning, nog niets goeds gevonden. Op 

televisie verdwijnt een deel van de beeldinformatie en worden de kleuren veel fletser. 
Oplossing: donkerdere kleuren en indien er contouren om objecten komen moeten deze dikker 
zijn. 

Week 46: Opzet bedacht voor online database. 
Week 47: Opzet nieuwe online database verder uitgewerkt. 
Week 3: Start gemaakt met website het “Verkeersjournaal”. 

http://www.chappin.com/martine/verkeersjournaal 
Week 6: Start gemaakt met webmapping service, demo gelokaliseerd bij GDMC (TUDelft). 
 http://webmap.geo.tudelft.nl/website/verkeersjournaal 
Week 13: Nieuwe kleuren gevonden, aan de hand van Falkplan-kaart gemeente Den Haag. 
Week 14: Einde stage. 
 
 
Bijlage 3: Telefoonnummers van gemeenten 
 
Delft Bob Gelink 015-2602248  
Leidschendam-Voorburg    
Midden-Delfland  015-3804111  
Pijnacker-Nootdorp    
Rijswijk    
’s-Gravenhage DSB 070-3536653 Voorlichting Dienst Stadsbeheer 
’s-Gravenhage DSO 070-3536088 Voorlichting Dienst Stedelijke Ontwikkeling 
Wassenaar  070-5122335  
Westland  0174-673673   
Zoetermeer  079-3468400  
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Bijlage 4: Tabellen 
 

Tabel 1: “[straatnaam][gemeente][weeknummer][volgnummer].dbf ” 

WEGVAK_ID WEEK LABEL AUTO BUS FIETS 

wegnummer in 7 
decimalen 

weeknummer in 2 
decimalen 

(indien nodig) 
straatnaam 

“X” of “incident” of 
“omleiding” 

“X” of “incident” of 
“omleiding” 

“X” of “incident” of 
“omleiding” 

 

Tabel 2: “kader.dbf”, “incident.dbf” en “incident_vlakken.dbf” 

ID NAME NAME2 

0 item naam gemeentenaam of een ander toevoeging 

 
 
Bijlage 5: Wie doet wat bij het “Verkeersjournaal” 
 
Bij het “Verkeersjournaal” zijn redelijk wat mensen betrokken, onderstaande tabellen geven de functies van 
de diverse medewerkers weer. De eindredacteur is eindverantwoordelijke van het geheel, maar hoeft in 
veel gevallen niet alles zelf te doen. 
 

Taken van eindproducent/eindredacteur/programma technicus autocue: 

MAANDAG 
 vergadering 
 planning samenstellen en lijstje cameraman 

DINSDAG 
 instrueren cameraman (bandje meegeven + lijst en kaartjes) 
 teksten schrijven 
 voorlopige teksten mailen naar Kirsten van Dissel 
 voorlopige planning (en planning voor de week daar op) op papier zetten 

WOENSDAG 
 spotten shots (briefje met tijdcodes maken) 
 eventueel materiaal uit archief halen 
 monteren (eventueel eerst banden laten zwarten) 
 montage naar regie (plus briefje met tijdcodes) 
 kaarten op een rij zetten en draaiboek eventueel aanpassen 
 checken of kaarten naar regie zijn gebracht 
 teksten schrijven en mailen naar webmanager en online (voor teletekst en website) 
 definitieve teksten naar Kirsten sturen 
 kopieën draaiboeken 3 stuks, sorteren op zo/wo, ma/do, di/vrij 
 alles in kast! 
 definitieve planning (en planning voor de week daar op) sturen naar: 

- Dienst Stadsbeheer 
- Dienst Stedelijke Ontwikkeling 
- Stadsgewest Haaglanden 
- HTM NV 

VRIJDAG 
 draaiboeken en opnamebandjes naar regie 
 begeleiden opnames en autocue bedienen 
 opnames op uitzendband zetten 
 agenda bijwerken (noteren wanneer aangekondigde afsluitingen stoppen of andere fase ingaan) 
 vergaderingen voorbereiden (kijken welke items er aan komen en welke nog te gebruiken zijn) 

 
De eindredacteur stuurt alle andere medewerkers aan, waaronder de cameraman en de 
bureauredacteuren.  
 

Taken cameraman: 

DINSDAG 
 shots maken op locatie volgens instructie: 

 - beeld op statief 
 - geen pan, geen zoom 
 - links kadreren 
 - rekening houden met format 

 
De bureauredacteuren bij dit programma verzamelen informatie over de werkzaamheden en omleidingen 
en maken daarvan kaarten. 
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Taken bureauredacteur(en): 

DINSDAG 
 informatie interpreteren 
 coderen 

WOENSDAG 
 kaarten maken 
 kaarten sturen naar eindredacteur 
 kaarten vergelijken met teksten, zonodig aanpassen of aanvullen 
 kaarten branden op CD-RW en naar vormgeving brengen 

 
 

 
Figuur 14: Kaart "Kamperfoeliestraat" - bureauredactie 

 
 
Wanneer de kaarten klaar zijn, worden deze gecontroleerd door de eindredacteur en verstuurd naar de 
vormgever. 
 

Taken vormgever: 

WOENSDAG 
 kaarten in kader plakken 
 kaarten verkleinen 
 kaarten in ander format (TIFF) zetten 
 bestanden branden op CD-RW en naar regie brengen 

 
 

 
Figuur 15: Kaart "Kamperfoeliestraat" - vormgeving 

 
 
Wanneer de kaarten helemaal klaar zijn, gaan ze naar de regie, waar ze in de schakelcomputer worden 
gezet. Op de dag van de opnames, worden alle onderdelen van de uitzending gecombineerd tot een 
programma van twee minuten. Normaal gesproken wordt er op vrijdagochtend tussen 11.00u en 13.00u 
opgenomen. 
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Taken kleedster/grimeur: Taken presentatrice: 

VOOR VRIJDAG 
 kleding uitzoeken 

VRIJDAG 
 helpen bij verkleden 
 grimeren 
 koffie/thee/water verzorgen voor tijdens de opnamen 
 controleren kleurkleding in combinatie met het licht 
 grime bijwerken wanneer nodig 

DONDERDAG 
 teksten lezen 

VRIJDAG 
 verkleden 
 laten grimeren 
 repeteren 
 presenteren 
 afschminken 

 
Taken programma technicus audio: Taken programma technicus video/camera: 

VRIJDAG 
 geluid afstellen 
 schuiven openen en sluiten 

VRIJDAG 
 shots laden 
 camerapositie regelen 
 bandopname verzorgen 
 shots starten 

 
Taken regisseur/programma technicus schakelen: 

VRIJDAG 
 algehele opname leiding 
 beeldkleuren instellen 
 camerapositie regisseren 
 kaarten laden in DVO (kan ook iemand anders doen die erbij zit) 
 kaarten (kan ook iemand anders doen die erbij zit) en shots controleren 
 beeldinsnijdingen aangeven 

 
 
Bijlage 6: Infographics bij andere programma’s 
 
Experiment “Brand in Delft”: 

 Toon regelt ondergrond (GBKDelft – Bob Gelink 015-2602248) 
 kaartje tekenen, wat is mogelijk? kaartje voorleggen aan de redactie 
 info verzamelen, in kaartje tekenen en laten bewerken door vormgeving 
 kaartje in de uitzending van dinsdag 28 oktober 2003 (resultaat in Figuur 9) 

 
Plannen gemeente Leidschendam-Voorburg: 

 snel info verzamelen, in kaartje tekenen en zelf bewerken bij vormgeving 
 kaartje in de uitzending van woensdag 5 november 2003 (resultaat in Figuur 16) 

 
Noordelijke Randweg Leidschendam-Voorburg 

 snel info verzamelen, kaartje maken naar aanleiding van kaartje in het “Verkeersjournaal”, laten 
bewerken door vormgeving 

 kaartje in de uitzending van donderdag 13 november 2003 (resultaat in Figuur 17) 
 
Grafiekje over stijging toeristenbelasting 

 tabel digitaliseren en grafiekje maken 
 opmaak zoeken (resultaat is niet goed, maar het moest heel snel) 
 kaart in de uitzending van dinsdag 13 januari 2004 (resultaat in Figuur 18) 

 
Bijzetting Koningin Juliana 

 vergadering met de eindredacteur over de live-uitzending van die dag 
 informatie verzamelen bij de gemeenten Den Haag en Delft (Den Haag was goed voorbereidt, Delft niet) 
 kaarten maken en naar vormgever sturen 
 kaarten in de uitzending van dinsdag 30 maart 2004 (enkele resultaten in Figuur 19 en Figuur 20) 

 
Kaart als object bij “Agnes van de kaart” 

 beeldvullende kaart maken en exporteren als *.aif 
 mailen naar vormgeving 
 resultaat: pop op zachtboard (1,5 meter) met een kaart in handen (zie Figuur 21) 
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*.aif is een formaat waarbij de originele vectorinformatie behouden blijft, zodat schaalbaarheid in een latere 
fase van de vormgeving geen probleem is. Formaten als *.bmp en *.jpg bestaan slechts uit al dan niet 
gecomprimeerde informatie over locatie en kleur van pixels en het detailniveau is daardoor beperkt. 
 
Om in het vervolg het maken van de kaarten nog soepeler te laten lopen, kan over een aantal zaken van 
tevoren worden nagedacht en kunnen een aantal zaken al voorbereid worden, bijvoorbeeld: het maken van 
een standaard bestand, dat naar eigen voorkeur kan worden aangepast en het verzamelen van 
telefoonnummers van GIS-specialisten bij de gemeenten in de regio. 

Het is verstandig om bij het maken van een kaartje aan de betreffende redacteur duidelijk te vragen wat 
hij of zij verwacht en wat de exacte situatie is. De beeldverhouding van de kaarten voor het journaal moet 
4:3 zijn, dan komen ze het best uit. 

 
 

 
Figuur 16: Plannen gemeente Leidschendam-

Voorburg 

 

 
Figuur 17: Noordelijke Randweg gemeente 

Leidschendam-Voorburg 

 

 
Figuur 18: Toeristenbelasting 

 
Figuur 19: De route 

 

 
Figuur 20: Afgesloten straten in Den Haag 

 
Figuur 21: "Agnes van de kaart " 
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Appendix: Werkbeschrijving ArcGIS 8 
 
Om de kaarten te maken voor het “Verkeersjournaal” moeten de volgende stappen genomen worden: 
Let op in iedere beschrijving staat [SGWV] voor [straatnaam][gemeente][weeknummer][volgnummer]. 
 

 Bekijk alle papieren documentatie van de week waaraan gewerkt gaat worden. 
 Open “dbf\[SGWV].dbf” en “D:\ARCDATA\VERKEERSJ\”. 

 
Kaart 1 - overzichtskaart: 

 Open “D:\ARCDATA\VERKEERSJ\basiskaart01.mxd”. 
 Klik “View > Data View”. 
 Dubbelklik op de Layer “kader”, klik op tabblad “Symbology”, verwijder het vinkje bij “all other vallues” en 

klik op “add vallues”, zoek de betreffende straat, selecteer deze en klik “OK”. Wanneer het goede kader 
er niet bij staat kijk verder onder het onderdeel: “Het rode kader”. 

 Dubbelklik op het symbool dat voor de straatnaam verschijnt, klik “kader” en klik tweemaal “OK”. 
 Dubbelklik op het tekstblokje met de rode letters, verander de tekst in de betreffende straatnaam.  
 Klik “OK”, ga met de muis op de tekst staan en versleep de tekst, zodat deze aan de rechterbovenkant 

van het rode kader staat. Klik in de Noordzee om de tekst te deselecteren. 
 Klik “View > Layout View”. 
 Klik “File > Save As…”,  noem het bestand “[SGWV]01.mxd” en klik op “Opslaan”. 

 
Kaart 3 en 2 – omleiding auto en detailkaart incident deel 1: 

 Open “D:\ARCDATA\VERKEERSJ\basiskaart02.mxd”. 
 Klik “View > Data View”. 
 Rechterklik “VV_NWB_PZH”, klik “Joins and Relates” in het menu en selecteer dan “Join”. 

 
 

 
Figuur 22: Join Data 

 
 In het “Join Data” dialoogvenster, selecteer “WVK_ID” als het veld waarop de ‘join’ gebaseerd wordt. 
 Kies “[SGWV].dbf” als de tabel om te ‘joinen’ en kies dan “WEGVAK_ID” als het veld in “[SGWV].dbf” 

waarop de ‘join’ is gebaseerd. 
 Klik tweemaal op “OK”. 
 Klik “File > Save As…”,  noem het bestand “[SGWV].mxd” en klik op “Opslaan”. 

 
Kaart 3 en 2 – omleiding auto en detailkaart incident deel 2: 

 Open “[SGWV].mxd” 
 Dubbelklik op de Layer “VV_NWB_PZH”, klik op tabblad “Symbology” en in “show” “Categories > Unique 

Vallues, Many Fields”. 
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 Selecteer voor “Vallue Field” het veld “[SGWV].STRAAT” en “[SGWV].AUTO”. Verwijder het vinkje bij 
“all other vallues” en klik op “add vallues”. 

 
 

 
Figuur 23: Layer Properties 

 
 Klik op “Complete List”, selecteer “[straatnaam],incident” en “[straatnaam],omleiding” en klik “OK”. 
 Dubbelklik op het symbool dat voor “incident” verschijnt, klik “verkeersjournaal/incident” en klik “OK”. 
 Dubbelklik op het symbool dat voor “omleiding” verschijnt, klik “verkeersjournaal/omleiding auto”. Klik 

tweemaal “OK”. 
 Verwijder de vinkjes voor de “Layers” die boven “VV_NWB_PZH nr 2” staan. 
 Klik “View > Data View”. 
 Klik op “Label”in de toolbar “Draw”. 

 
 

 
Figuur 24: Labeling Options 

 
 Zorg dat in het window dat verschijnt, de rondjes bij “Place label at position clicked” en “Choose a style > 

incident” zijn geselecteerd, ga met je muis op straat staan die afgesloten is en klik zodra de straatnaam 
verschijnt. TIP: Refresh het beeld regelmatig. 

 Verander de “style” in “Omleiding auto” en plaats ook de benodigde straatnamen van de omleiding. 
 Selecteer het pijltje in de toolbar “Draw” en selecteer alle gemaakte straatnamen. Rechterklik op één 

van de geselecteerde straatnamen. Het is opvallend dat er blokken verschijnen die met de wegen mee 
staan en dat is lastig, om dit te veranderen, klik “Properties”. Vul voor “Angle” “0” in. Nu staan de 
blokken om de straatnamen. Klik buiten de selectie, om alles te deselecteren. Refresh het beeld. 
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Figuur 25: Properties 

 
 Zet alle vinkjes voor de “Layers” weer aan en controleer of alle benodigde straatnaamlabels 

aangemaakt zijn. 
 Klik “View > Layout View”. 
 Alle straatnamen staan nu waarschijnlijk nog door elkaar, deze zijn te verplaatsen door te klikken op de 

tekst en deze te slepen naar de gewenste plaats. De tekst is te veranderen door er dubbel op te klikken 
en deze naar keuze te wijzigen. 

 Klik “File > Save As…”,  noem het bestand “[SGWV]03.mxd” en klik op “Opslaan”. 
 Klik “View > Data View”. 
 Selecteer alle straatnamen van de omleidingsroute en verwijder deze. 
 Klik “View > Layout View”. 
 Dubbelklik “VV_NWB_PZH”, klik op tabblad “Symbology”, klik op het symbool voor “omleiding”, klik 

“Remove” en klik “OK” 
 Klik “File > Save As…”,  noem het bestand “[SGWV]02.mxd”, waarbij en klik op “Opslaan”. 

 
Kaart 4 en verder – omleiding OV en fiets: 

 Klik “File > Open…”, dubbelklik “[SGWV]03.mxd”. 
 Dubbelklik op de Layer “VV_NWB_PZH”, klik op tabblad “Symbology” en in “show” “Categories”. 
 Selecteer voor “Vallue Field” het veld “[SGWV].STRAATNAAM” en “[SGWV].BUS”. Klik op “add vallues”. 
 Klik op “Complete List”, selecteer “[straatnaam],incident OV” en “[straatnaam],omleiding OV” en klik 

“OK”. 
 Dubbelklik op het symbool dat voor “incident OV” verschijnt, klik “verkeersjournaal/incident” en klik “OK”. 

 
 

 
Figuur 26: Symbol Selector 
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 Dubbelklik op het symbool dat voor “omleiding OV” verschijnt, klik “verkeersjournaal/omleiding OV”. Klik 
tweemaal “OK”. 

 Dubbelklik op de Layer “VV_OV2004”, klik op tabblad “Symbology” en in “show” “Categories > Unique 
Vallues”. Selecteer voor “Vallue Field” het veld “ID_”. Verwijder het vinkje bij “all other vallues” en klik op 
“add vallues”. Klik op “Complete List”, selecteer “***”, waarbij *** staat voor het nummer van de 
benodigde bus- of tramlijn en klik “OK”. 

 Dubbelklik op het symbool dat voor “***” verschijnt, klik “verkeersjournaal/OV” en klik “OK”. 
 Verwijder de vinkjes voor de “Layers” die boven “VV_NWB_PZH nr 2” staan. 
 Klik “View > Data View”. 
 Klik op “VV_NWB_PZH” en klik op “Label”in de toolbar “Draw”. 
 Zorg dat in het window dat verschijnt, de rondjes bij “Place label at position clicked” en “Choose a style > 

Omleiding OV” en plaats ook de benodigde straatnamen van de omleiding. Voeg ook het nummer van 
de betreffende bus- of tramlijn toe (in grijs en op de plaats waar de lijn het rode kader binnen komt). TIP: 
Refresh het beeld regelmatig. 

 Selecteer het pijltje in de toolbar “Draw” en selecteer alle gemaakte straatnamen. Rechterklik op één 
van de geselecteerde straatnamen. Het is opvallend dat er blokken verschijnen die met de wegen mee 
staan en dat is lastig, om dit te veranderen, klik “Properties”. Vul voor “Angle” “0” in. Nu staan de 
blokken om de straatnamen. Klik buiten de selectie, om alles te deselecteren. Refresh het beeld. 

 Zet alle vinkjes voor de “Layers” weer aan en controleer of alle benodigde straatnaamlabels 
aangemaakt zijn. 

 Klik “View > Layout View”. 
 Alle straatnamen staan nu waarschijnlijk nog door elkaar, deze zijn te verplaatsen door te klikken op de 

tekst en deze te slepen naar de gewenste plaats, alleen de nieuw toegevoegde mogen verplaatst 
worden. De tekst is te veranderen door er dubbel op te klikken en deze naar keuze te wijzigen. De 
straatnamen die overbodig zijn, kunnen verwijderd worden door ze te selecteren en op “delete” te 
drukken op het toetsenbord. Straatnamen kunnen ook alleen een andere kleur krijgen door er dubbel op 
te klikken, vervolgens op “Change Symbol…”, en de kleur te veranderen in de gewenste kleur. Selecteer 
niet een andere voorgeprogrammeerde “style”, want dan verandert de locatie van de tekst. Klik 
tweemaal “OK” 

 Klik “File > Save As…”,  noem het bestand “[SGWV]04.mxd” en klik op “Opslaan”. 
 Voor kaart 5, moeten dezelfde stappen worden gevolgd. Overal waar “BUS” of “OV” staat moet alleen 

“FIETS” komen te staan. 
 Klik “File > Save As…”,  noem het bestand “[SGWV]05.mxd” en klik op “Opslaan”. 

 
Het rode “kader”: 

 Open “D:\ARCDATA\VERKEERSJ\basiskaart02.mxd”. 
 Zoek de straat van het incident waar je mee bezig gaat. 
 Klik “View > Data View”. 
 Klik “Tools > Editor Toolbar”, de “Editor Toolbar” verschijnt dan. 
 Klik op deze toolbar “Editor > Start Editing”. Zorg dat bij “Source” “D:\ARCDATA\VERKEERSJ\” 

geselecteerd staat, klik “OK”. Controleer of als “Target” de laag “kader” geselecteerd staat. 
 
 

 
Figuur 27: Start Editing 

 
 Klik op het dichtstbijzijnde kader, klik “Edit > Copy” en vervolgens “Edit > Paste”. 
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 Rechterklik “Attributes” en vul bij “name” de nieuwe straatnaam in. Sluit “Attributes”. 
 Sleep het nieuwe kader naar de betreffende straat, zodat het kruisje in het midden van het kader 

midden in de straat valt. 
 Klik “Editor > Stop Editing” en klik “Ja”. 
 Klik “View > Layout View”. 
 Dubbelklik op de Layer “kader”, klik op tabblad “Symbology”, verwijder het vinkje bij “all other vallues” en 

klik op “add vallues”, zoek de betreffende straat, selecteer deze en klik “OK”. 
 
 

 
Figuur 28: Symbol Selector 

 
 Dubbelklik op het symbool dat voor de straatnaam verschijnt, klik “kader” en klik tweemaal “OK”. 
 Zoek met behulp van in- en uitzoomen in het beeld het kader, zet de schaal op “1:8000” en zorg dat het 

kader netjes links in de “Layout View” staat. 
 Klik “File > Save As…”,  noem het bestand “[SGWV]00.mxd”, waarbij ** staat voor de straatnaam en klik 

op “Opslaan”. 
 
Aanpassingen aan de kaart: 

 Niet alle onderdelen van de kaart zijn simpelweg in een tabel te zetten. In het geval van afgesloten 
kruisingen of éénrichtingsverkeer, moeten de volgende stappen worden genomen. 

 Open de kaart die bewerkt moet worden en controleer of onder “Layers” de laag “Incident” in het 
bestand is opgenomen. 

 Een “Layer” toevoegen kan door: rechterklik “File > Add Data…”. Zoek het bestand 
D:\ARCDATA\VERKEERSJ\incident.shp”. Selecteer en klik “Add”. 

 Klik “View > Data View”. 
 Klik op deze toolbar “Editor > Start Editing”. Zorg dat bij “Source” “D:\ARCDATA\VERKEERSJ\” 

geselecteerd staat, klik “OK”. Controleer of als “Target” de laag “incident” geselecteerd staat. 
 Klik op het potloodje (de “Sketch Tool”), het is nu mogelijk om nieuwe lijnen toe te voegen. 
 Zoom in tot de locatie van het gewenste nieuwe object vrijwel helemaal in beeld is. 
 Rechterklik dicht in de buurt van waar de nieuwe lijn moet beginnen. Klik “Snap To Feature > Vertex”. 

Rechterklik op het volgende punt. Klik wederom “Snap To Feature > Vertex”. Herhaal deze stappen tot 
en met het laatste punt. Rechterklik hierna “Finish Sketch”, nu staat het object in de kaart. 

 Om de naamgeving van het object te regelen, klik op de “Editor”-toolbar op het icoon “Attributes” en vul 
de straatnaam bij “name” en een extra (uniek) gegeven bij “name2” in, bijvoorbeeld: “javastraat, incident 
bus”. Sluit de “Attributes”-tabel met het kruisje rechtsboven. 

 Klik “Editor > Stop Editing” en klik “Ja”. 
 Klik “View > Layout View”. Zorg dat het vinkje voor de laag “incident”. 
 Dubbelklik op de Layer “incident”, klik op tabblad “Symbology > Categories > Unique vallues, many 

fields”, zorg dat geselecteerd staat “Vallue Fields > name, name2, <NONE>” en klik op “add vallues”, 
zoek de betreffende straat en unieke toevoeging, selecteer deze en klik “OK”. Wanneer de straat er nog 
niet bij staat, klik “Complete List” en probeer het nog eens. 

 Dubbelklik op het symbool dat voor de straatnaam verschijnt, verander waarnodig en klik tweemaal 
“OK”. 
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 Nu kunnen pijlen en dergelijke wel worden toegevoegd aan de kaart. 
 
Exporteren: 

 Open de te exporteren kaart “[SGWV]0X.mxd”, waarbij de X staat voor het kaartnummer 
 Klik “File > Export Map…”, noem het bestand “[SGWV]0X.jpg”. Klik “Options…”, sleep het blokje bij 

“Quality” naar iets meer dan ¾, het gevolg hiervan is dat het formaat van de kaart uit komt op ongeveer 
150 kB. Klik “OK” en klik “Export”. 

 
 

 
Figuur 29: JPEG Options 

 
 Doe dit voor alle kaarten. 
 Brandt alle de geëxporteerde kaarten op een CD-RW en breng dit naar de afdeling “Vormgeving”. 

 


